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Introduction

Congratulations on your purchase of the AlliedView™ Network Management System product. This product allows users to 
query all aspects of Allied Telesis products in their network.

Who Should Read This Guide?

This document is for users who need to deploy the AlliedView NMS product on Windows or Solaris platforms. For in-depth 
knowledge of the NMS and its applications, refer to the AlliedView NMS Administration Guide and the NMS User Guide.

About this Guide

This Guide covers all aspects of the AlliedView NMS 12.0 installation, including:

• The hardware and software requirements

• Any new features for installing, starting, and uninstalling the AlliedView NMS software

• The instructions for installing, restarting, and uninstalling the AlliedView NMS server / client software

This document describes the installation of the AlliedView NMS.

The content of this Guide is organized as follows:

Chapter 1 describes how to prepare for the installation

Chapters 2 describes how to install the AlliedView NMS on the Windows and Solaris platform

Chapter 3 describes how to install the AlliedView NMS Service Pack for 12.0.

Chapter 4 describes how to start up the AlliedView NMS Server and clients

Chapter 5 describes how to shut down the AlliedView NMS.

Chapter 6 describes how to uninstall the AlliedView NMS

Chapter 7 describes how to install and uninstall a Service Pack.

Chapter 8 gives installation scenarios and includes references when needed to other sections or documents.

The Appendices include how to enable anonymous ftp, how to activate the NMS software license, and the Licence Key form. 

Reason for Update

For AlliedView NMS release 12.0, there were the following changes:

• The R12.0 upgrade procedure was different than in previous releases, with an upgrade tool that is used only in release 12. 
Refer to Section 3.1.
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• The name of the NMS Administrative Service has changed from Telesyn NMS to AlliedView NMS. Refer to 4.1.1.

• The GUI path to perform various actions on the NMS, as well as the default path to the NMS home directory, has Allied 
Telesis added. Refer to 4.1.2 and 2.2.

• There is a new logon screen. Refer to 4.3.

These changes and the procedure to upgrade to R12.0 are included in this Guide. 

This issue concentrates on installing and uninstalling R12 SP1 and any other R12 Service Packs; this procedure is the same 
as in previous releases and is documented in Section 7.

Service and Support

For information about support services for Allied Telesis, contact your Allied Telesis sales representative or visit the website 
at www.alliedtelesis.com.

All company names, logos, and product designs that are trademarks or registered trademarks are the property of their 
prospective owners.
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1. Preparing for Installation
1.1  Types of Installation
There are two basic types of AlliedView NMS installations: a full installation and an Upgrade Pack. A full instal-
lation is used when installing the NMS for the first time on a host machine. A full installation copies all of the 
files required to run the NMS to your hard drive. The software is delivered on a CD-ROM or is downloaded from 
the web. (Please contact or local ATI representative, as the website requires an email address and password, at 
http://www.alliedtelesis.com/support/software/restricted/login.aspx.) Either method provides the necessary files, 
documentation, and the installer program that steps you through the installation process.

AlliedView NMS Upgrade Packs are designed to upgrade your NMS to the next major software release. 
Upgrade packs are mandatory and may not be skipped.

Service Packs are designed to service your AlliedView NMS with software bug fixes and are optional.

Service packs are inclusive of the previous SP so it is only necessary to apply the latest version. For example, if 
SP 3 is latest version applying it will also apply the contents of SP 1 and SP 2.
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System Requirements Client, Browser, and Server
1.2  System Requirements

1.2.1  Client, Browser, and Server
The system requirements for the AlliedView NMS are listed in the following table.

1.3  Getting Started
If you are not familiar with the AlliedView NMS, you may want to review the product documentation prior to 
installation to familiarize yourself with the AlliedView NMS. There are two user documents provided in addi-
tion to this Guide: the AlliedView NMS Administration Guide, and the NMS User Guide. The NMS Administra-
tion Guide describes the tasks associated with the administration of the AlliedView NMS. The NMS User Guide 
describes the NMS user interface and how it is used. You may need to refer to the NMS Administration Guide 
during the installation process. Locate this document before you start.

TABLE 1-1  AlliedView NMS System Requirements  - Numbers in bold and ( ) are Recommended

Requirement Windows Solaris

Enterprise Edition Server 
(EE)

Windows Only

OS: Windows Server 2003 or 2008 (XP 
acceptable)

Less than 500 Nodes:

Processor: Intel Xeon E5530, 2.4GHz, 8M 
Cache (or equivalent)

RAM:2GB Disk: 20GB 

DVD/CD Drive - Drive is optional

Greater than 500 nodes:

Processor: Dual Intel Xeon X5550, 2.66GHz, 
8M Cache (or equivalent)

RAM: 4GB Disk: 20GB

DVD/CD Drive - Drive is optional

Not Applicable

Service Provider Edition 
(SE)

OS: Windows Server 2003 or 2008

Processor: 

- Intel Xeon dual core processor 2GHz, or 
equivalent

- (Intel Xeon quad core processor 2.4GHz, 
or equivalent)

RAM: 4 GB (4GB)

Disk: 20GB (20GB)

Monitor: 1280x1024 resolution

OS: Solaris 10

Machine: SPARC Enterprise T1000 
(T5120)

Processor: 

- UltraSPARC T1 1.0 GHz

- (UltraSPARC T2 1.2 GHz)

RAM: 4GB (8GB)

Disk: 20 GB (20GB) 

Monitor: 1280x1024 resolution

NMS Client OS: Windows 2003/2008/XP/Vista

Processor: 1 GHz, RAM: 2GB

Java JRE version 1.6.0_16

Monitor: 1280x1024 resolution

OS: Solaris 10

Processor: 1 GHz, RAM: 2GB

Java JRE version 1.6.0_16

Monitor: 1280x1024 resolution

Browser (Platform Inde-
pendent)

Explorer 7.0 and above

Mozilla 3.0 and above 

Mozilla 3.0 and above 
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Client, Browser, and Server Preparing for a Full Installation
Release Notes are provided with each installation CD. These notes contain important information regarding the 
release or Upgrade Pack you are installing. Before installing your AlliedView NMS software or Upgrade Pack, 
carefully review the Release Notes and follow any special instructions that may be provided.

Note: You may want to print the Release Notes for future reference.

The preparation required depends on the type of installation you are performing. If you are performing a full 
installation, refer to 1.4. If you are performing an Upgrade Pack installation, refer to 1.5.

1.4  Preparing for a Full Installation
Before starting the installation, you must verify that the host machine or machines on which you plan to install 
the AlliedView NMS meet the requirements described in Table 1-1. If any host machine upgrades are necessary, 
you must perform these upgrades prior to installing the AlliedView NMS. Upgrading host machines is not cov-
ered in this document. You will need to refer to the documentation provided with your host machines for these 
procedures. Do not install or upgrade the AlliedView NMS on a machine until the machine meets the stated 
requirements.

Caution: The AlliedView NMS server must have a static (rather than dynamic) IP address. 
Otherwise, traps will not be routed correctly.

If the host machines meet the requirements, you are now ready to begin the installation process. An installation 
CD-ROM is provided with your AlliedView NMS. If you have not already done so, locate and unpack this CD-
ROM.

You are now ready to begin. If you are installing the NMS on a Windows platform, refer to 2.2. If you are install-
ing the NMS on a Solaris platform, refer to 2.3.

Note: Only one version of the NMS may exist on the systems. Uninstall previous versions of the 
NMS or use the Upgrade Pack process to upgrade.

1.5  Preparing for an Upgrade to 12.0
To upgrade to R12.0, there is a special procedure that must be followed. This is explained in Section 3.
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Preparing for an Upgrade to 12.0 Client, Browser, and Server
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2.  Installation (Service Provider / 
Enterprise Edition)
2.1  Overview
The AlliedView NMS software is loaded on one server, which provides all the required functionality.

Note: Anonymous FTP is used by the NMS to manage certain devices, and therefore must be 
enabled on the server. Refer to Appendix A for instructions.

FIGURE 2-1  Single Server Configuration
2-1 AlliedView NMS Installation Guide (Installation (Service Provider / Enterprise Edition))



Installing on a Windows Platform (Service Provider and Enterprise Edition)
2.2  Installing on a Windows Platform (Service Provider 
and Enterprise Edition)
To install the AlliedView NMS on a Windows platform, follow these steps.

1. For a CD-ROM, insert the  installation CD-ROM in the CD-ROM drive. After approximately 60 seconds, the 
InstallShield® Wizard Installer screen will appear, as shown Figure  2-2.

2. For a download from the Allied Telesis restricted website, click on AlliedView NMS in the pull down, find 
the NMS R12.0 for Windows panel, and select the type of  NMS 12 for Windows Installation package (Ser-
vice Provider or Enterprise Edition). Click on the link, and you are prompted to download the following files:
• AlliedViewNMS_12_0_SE_Windows.exe (Service Provider)
• AlliedViewNMS_12_0_EE_Windows.exe (Enterprise)

Save the file to the server, and then double click to launch. After approximately 60 seconds, the 
InstallShield® Wizard Installer screen will appear, as shown Figure  2-2

FIGURE 2-2  AlliedView NMS Installation Wizard Screen
3. On the Installer screen, click Next. This will display the license agreement page shown in the following fig-

ure.
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Installing on a Windows Platform (Service Provider and Enterprise 
FIGURE 2-3  AlliedView NMS Installation Wizard License Agreement
4. Carefully read the license agreement, click the I accept the terms of the license agreement radio button, and 

then click Next.

Note: If you do not wish to proceed with the installation, click Cancel to exit.

The next screen will specify the installation directory. Refer to the following figure.
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Installing on a Windows Platform (Service Provider and Enterprise Edition)
FIGURE 2-4  Specify Directory path
5. Although you can change this directory, it is highly recommended that you use the default directory pro-

vided. Click Next.
6. The next screen displays the selected installation directory and indicates the total size of the installation (in 

Mb). If you need to make a change, click Back and make the change. If you wish to exit, click Cancel. Oth-
erwise, click Next.

7. This will display the installation progress window shown in the following figure. 
AlliedView NMS Installation Guide (Installation (Service Provider / Enterprise Edition))2-4



Installing on a Windows Platform (Service Provider and Enterprise 
FIGURE 2-5  AlliedView NMS Installation Wizard Installation Progress
The progress bar tracks the progress of the installation. It will take a few minutes for the installation to com-
plete. When the installation completes, the Services window, shown in the following figure, will appear.
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Installing on a Windows Platform (Service Provider and Enterprise Edition)
FIGURE 2-6  AlliedView NMS Installation Wizard File Installation
8. The screen in Figure  2-6 prompts you to choose whether to install the AlliedView NMS as a Windows ser-

vice, which allows the AlliedView NMS to automatically start up on Windows startup and shut down on 
Windows shutdown.

Note: It is highly recommended that you install the AlliedView NMS as a Windows Service.

 Select Automatic if you want the AlliedView NMS as a service. Otherwise select Manual. Click Next.

9. The next screen will confirm the successful installation of the AlliedView NMS. Click Next. 
10. The next window will ask you whether you want to restart your computer now or at a later time. If you want 

to restart now, select Yes. Otherwise, select No. Refer to the following figure.
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Installing on a Windows Platform (Service Provider and Enterprise 
FIGURE 2-7  AlliedView NMS Installation Wizard File Restart Option
Note: If you selected Yes, your computer will restart when you click Finish. Before restarting your 

computer, if you have any Windows applications open other than the AlliedView NMS 
Installation Wizard, close them now. If you selected No, this is not necessary, with a note that 
the NMS can be started using the Services menu.

11. Click Finish to complete the process.

 If you selected Automatic to restart in the previous window, when your computer restarts, the NMS server 
starts, and then you will get the AlliedView NMS Client logon window. If you want to log in, enter root as the 
username and public as the password, and then click Connect. Otherwise, click Cancel to terminate the login 
process.

Note: The InstallShield adds the NMS Client startup program to your Windows Startup menu, which 
means the client will start automatically when a user logs into Windows.

If you do not want the client to start automatically, remove AlliedView NMS Client from your Windows Startup 
menu by right-clicking on it, and then selecting Delete from the pop-up menu.

You have completed the installation process. To start the AlliedView NMS, refer to Chapter 4.
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Installing on a Solaris Platform (Service Provider Only)
2.3  Installing on a Solaris Platform (Service Provider 
Only)
To install the AlliedView NMS on a Solaris platform as a daemon, follow these steps:

1. On the machine on which the AlliedView NMS is to be installed, log in as root or as a user with root privi-
leges.

2. Insert the installation CD-ROM into the CD-ROM drive.
3. Start the Wizard manually by executing the AlliedViewNMS_12_0_SE_Solaris.bin file.

Note: For best performance first copy the Installer (AlliedViewNMS_12_0_SE_Solaris.bin) to a 
hard drive location.

Note: The Solaris Installer requires 1.5 GB of temporary disk space to properly complete the 
installation process. It is recommended the /tmp directory be used for this purpose.

Note: Finally, it is recommended that a log file be created so any problems during installation can be 
tracked. The recommended command syntax is therefore:

 
% AlliedViewNMS_12_0_SE_Solaris.bin -is:tempdir /tmp -is:log /tmp/
nms_install_log.txt

4. Once the Installation Wizard starts, follow the instructions provided by the Installation Wizard. The instruc-
tions are identical to those provided during the installation on the Windows platform. For specific informa-
tion on following the Wizard instructions, refer to Chapter 2.

Note: The default installation directory for the AlliedView NMS on the Solaris platform is /opt/
AlliedTelesis/AlliedViewNMS. Although you can change this directory, it is highly 
recommended that you use the default directory provided.

5. Once installation is complete, start the AlliedView NMS. Refer to Chapter 4.
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3. Installing the R12.0 Upgrade Pack 
- Service Provider Edition Only
3.1  Overview
An upgrade pack is used to bring your AlliedView NMS to the next major software release. The process is iden-
tical for both Windows and Solaris. In R12.0 the same upgrade pack is used for Solaris and Windows.

Note: Since various software components of the NMS have been replaced in R12.0, the procedure in 
to upgrade to R12.0 is different for this release; you must follow these steps to ensure a 
successful upgrade.

Note: Since the Enterprise Edition is newly released in R12.0, there is no upgrade procedure.

3.2  Upgrading the NMS Server

3.2.1  Prerequisites
The following conditions must be met so that the upgrade can proceed without error. (Some of these are 
explained in more detail during the specific steps.) 

• The server must be running at R11 SP5 or R11 SP5.x.

Note: The R11 software will be referred to as R11 SP5 from here forward.

• The R11 SP5 installation directory should be examined and cleaned prior to applying the R12.0 Service Pack. 
Examples are TFTP and swdownload directories (for Windows).

• The upgrade must be performed on the same physical server.
• The server must have enough disk space to hold the software needed for the R12.0 upgrade. This would 

include the current R11 SP5 installation, at least one R11 SP5 backup, and the R12.0 installation (100G).

The upgrade to R12.0 involves these main steps:

1. Ensure that the current NMS is at release R11 SP5 and ready to be upgraded.
2. Make a backup of the R11 SP5 system, then shut down the NMS R11 SP5 server. 
3. Verify that all processes are shut down (Apache, java.exe, mysqld.exe) as follows:
• Windows

• Ensure that the TelesynApache and Telesyn NMS services are set to manual and are stopped.
• You can check the Windows Task Manager to make sure that NMS, Apache and MySQL are not running 

by looking for any java.exe, Apache.exe and mysqld.exe processes
• If any of these processes are still running after ensuring that the NMS server is shutdown and the Win-

dows services are stopped, you can use the ShutDown.bat script to attempt to stop them
• There is also an AT_ShutDownMySQL.bat that can be use if the mysqld.exe process fails to stop running.

• Solaris
• Ensure that the AlliedViewNMS is stopped by shutting down the R11 NMS server (ShutDown.sh).
• Ensure that the AlliedViewNMS service is removed using the R11 AT_regdaemon.sh –dereg script. 

This will prevent R11 from starting should the server reboot unexpectedly.
• You can check to see if any of the R11 processes are running by using the ps command and looking for 

processes that have the R11 path.
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• Similar to Windows, if you see any R11 processes running, you can use the ShutDown.sh and the 
AT_ShutDownMySQL.sh scripts to attempt to stop these processes.

4. Install R12.0 on the same server. The R12.0 install uses a different path than R11 SP5. The default paths are:
• Windows

• R11 default path is C:\Program Files\Allied Telesyn\AlliedView NMS
• R12 default path is C:\Program Files\Allied Telesis\AlliedView NMS

• Solaris
• R11 default path is /opt/AlliedViewNMS
• R12 default path is /opt/AlliedTelesis/AlliedViewNMS

Use the R12 Update Manager application for this process.

Note: Once the R12.0 install is running successfully, and all data verified, you may un-install R11 
SP5. Note that you do not need to restart the server once this is done, since there would be 
an interruption of the NMS during the restart.

3.2.2  Prepare the Server
The server to be upgraded must be running at release R11 SP5 and R11 SP5.x. In addition, the server should be 
examined and any unnecessary files removed. Examples of such files are:

• Unused files in the Software Downloads directory (swdownload)
• Unused files in the tftp directory

Note: To upgrade to R11 SP5, you must use the upgrade procedure in the NMS AlliedView 
Installation Guide for release R11.0. The upgrade procedure described here is for R12.0 only.

3.2.3  Back up the R11 SP5 and Shut down the R11 SP5
Perform a backup of the R11 SP5, following these steps. (These are the standard steps as described in detail in 
the AlliedView NMS Administration Guide).

1. Choose from the main menu Tools -> NMS Database Backup, and the option On Demand. A dialog box 
appears with a reminder that the database will be paused during the backup.

2. Clicking OK starts the backup process window. When finished, the window will show whether the backup 
was successful and where the backup was written to.

3. Shut down the R11 SP5 server. Refer to 5.2 for the main steps and 3.2.1 on ensuring all relevant processes 
are shut down.

3.2.4  Install R12.0 (New Install)
The installation of a R12.0 new install will, by default:

• Place the applications and files in a new location (different path) than the R11 SP5 installation.
• Create an NMS service that is different than the R11 SP5 service.

To install R12.0, follow the steps that are in 2.2.

Be sure to choose either the default directory path for the R12.0 files or a path that is different than the R11 SP5.

Note: Do not start the NMS server, or restart your computer.

3.2.5  Perform the Upgrade with the R12.0 Upgrade Manager
Follow these steps:

1. On the R12 install, launch the Update Manager, using one of the following methods:
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Perform the Upgrade with the R12.0 Upgrade Manager Upgrading the NMS Server
• For Windows, go to the directory shown in FIGURE 3-1 and double-click Updatemanager.bat, or fol-
low the program path GUI as shown in FIGURE 3-2.

• For Solaris, go to the <NMS home>/bin directory and input ./UpdateManager.sh
• For the Solaris console version, input ./UpgradeManager.sh -c (The ppm and backup files must be in 

<NMS_home>, or you can give the full path when prompted.)

FIGURE 3-1  Launching the Update Manager (Double-click the File)

FIGURE 3-2  Launching the Update Manager (GUI Path)
2. The AlliedView Update Manager GUI appears. In the Update panel, select the Browse button to find the R12 

ppm file that is going to be used, as shown in the following figure.
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FIGURE 3-3  Selecting the ppm file
3. Select the R12 ppm file and Click on Open. The Install and Readme buttons are now active. (The Readme 

file and the R12 Release Notes also explain the what the ppm file does.) 
4. Click on Install. The Installation Wizard appears and reads in the ppm file. The system then prompts you to 

select the R11 SP5 backup file, as shown in the following figure.

FIGURE 3-4  Selecting the Backup File
5. Select Open. The Installation Wizard now extracts the files. (This should take approximately 10-15 minutes, 

depending on the size of the files.)
6. When the Installation Status reaches 100%, the message “Post invocation” appears, and then the message 

“Updating Database” appears as the database is converted. The time for this to finish depends on the size of 
the database. When this is complete, the message “Service Pack installed successfully” appears.
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FIGURE 3-5  Update Manager Complete (Service Pack Installed)
7. Select Close to close the Installation Wizard. The AlliedView Update Manager GUI now contains the 

installed Service Pack, as shown in the following figure. (You can click on Details to get additional informa-
tion on the Service Pack.).

FIGURE 3-6  Service Pack Installed
8. Click on Exit. The Service Pack is installed.
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3.2.6  Start the R12.0 NMS Server
Refer to Section 4.

3.2.7  Ensure R12.0 is Running Correctly
Once R12.0 is installed and running, you should verify that all functions of the NMS function correctly. Exam-
ple functions to verify are:

• Client launches successfully.
• All applications for devices launch and work as previously.
• All user IDs and passwords work.
• Security access features work the same as previously.
• All network maps have the correct devices and labels.
• Network Inventory has the correct devices and labels.
• The alarm panel has no unexpected status change.
• tftp and swdownload 

Note: At this point you have the option to uninstall R11 SP5. Note that you do not need to restart the 
NMS server when prompted, since would take the NMS server temporarily out of service.

If any of these do not seem to work as previously, or there is some problem that should not be occurring, contact 
your Allied Telesis representative before taking any recovery action such as what is included in 3.2.8.

3.2.8  Recovery (Uninstall R12.0 and Restart the R11.0 SP5 Software)
If, as described in Section 3.2.7, you have upgraded to R12.0 and now, after consulting with ATI, R11.0 SP5 
must be reinstalled, follow this procedure. The main steps to perform are:

• Uninstall the R12.0 Update Pack, the AlliedView_NMS-12.0-SP-0.0 (using the Update Manager and select-
ing the Uninstall option).

• Uninstall the NMS R12.0 software.
• Restart the R11 SP5 software.

These steps are outlined in detail below.

1. Shut down any client connections and the NMS R12.0 server. Refer to Section 5.
2. Relaunch the AlliedView Update manager, to bring up the screen in Figure  3-7. Click Uninstall.
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FIGURE 3-7  Uninstalling the R12.0 AlliedView Update
3. A confirmation screen appears asking whether to proceed with the Uninstall. Refer to Figure  3-8. Select Fin-

ish to proceed, and the Progress screen shows the uninstallation taking place, as shown in Figure  3-9.

FIGURE 3-8  Confirm Uninstalling (Select Finish)
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FIGURE 3-9  Uninstallation Progress Screen

4. When completed, the Uninstalled label appears, as shown in Figure  3-10.

FIGURE 3-10  Upgrade Pack Uninstallation Complete
5. Uninstall NMS R12.0. Refer to Section 6.
6. Restart NMS R11 SP5. In the Services window, select Telesyn NMS (R11 SP5) service. Refer to Figure  3-

11.
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Recovery (Uninstall R12.0 and Restart the R11.0 SP5 Software) Upgrading the NMS Server
FIGURE 3-11  Service Window for NMS R11 SP5 Release
7. Right-click and select Properties. The Properties window opens, as shown in Figure  3-12. In the Startup 

type drop-down, select Automatic (recommended), and then Click OK.

FIGURE 3-12  Properties for Service Window
8. Repeat Steps 6 and 7 for TelesynApache service (usually the next item after TelesynNMS in the Service win-

dow.) Refer to Figure  3-13.
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FIGURE 3-13  Selecting Properties for TelesynApache Service
9. In the Services window, right-click TelesynApache service, and select Start (Figure  3-14). Repeat for Tele-

syn NMS service. 

FIGURE 3-14  Restarting TelesynApache Service
10. You can now start NMS R11 SP5 clients and use the R11 SP5 server.
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4. Starting Up AlliedView NMS 12.0
4.1  Starting the AlliedView NMS Server on Windows
If you chose to install the AlliedView NMS as a Windows automatic Service, the AlliedView NMS Server will 
start automatically when your computer is restarted. If you left the AlliedView NMS Client menu item in your 
Windows Startup menu, the AlliedView NMS Client will also start automatically when your computer is 
restarted. In this case, no further action is required, as both the server and client will be started automatically 
when a user logs in.

If you chose not to install the AlliedView NMS as an automatic Service, you will have to start it manually. Like-
wise, if you removed the AlliedView NMS Client item from your Startup menu, you will have to start the client 
manually. There are two ways in which you can manually start the AlliedView NMS Server: from the Start menu 
or from the Administrative Tools Services window. The following sections describe how this is done.

Note: If you have a invalid or expired license key, you will receive a message and the startup will 
terminate. Refer to starting the NMS, you must have a valid license key. For information on 
license keys, refer to Section 12.

Note: In the Windows Application Event viewer, the error “AlliedView NMS service hung on starting” 
is occasionally observed at system start up. To verify NMS service started correctly, connect 
the NMS Client. If successful, the message may be ignored. Otherwise attempt to restart the 
AlliedView NMS service via the Windows Service Manager. If the problem persists, contact 
Allied Telesis Support.

4.1.1  Starting the NMS Server from the Services Window
When you installed the AlliedView NMS software, item AlliedView NMS was added to your Windows Ser-
vices. To see this item, follow these steps:

1. Select Start -> Settings -> Control Panel to access the Control Panel on your computer.

Note: You can also double-click My Computer, and then double-click Control Panel in the My 
Computer window.

2. In the Control Panel, double-click the Administrative Tools folder.
3. In the Administrative Tools folder, double-click Services. The Services window will appear.
4. In the Services window, scroll down until you find item AlliedView NMS. This item is the AlliedView NMS 

Service. Refer to the following figure for an example.
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FIGURE 4-1  AlliedView NMS Automatic Service
 If you chose not to install the NMS as an automatic Service, the AlliedView NMS service Startup Type will be 
shown as Manual and the Status field will be blank in the Services window as shown in the previous figure. 

Note: If AlliedView NMS is an automatic Service, the Startup Type will be Automatic.

To manually start the AlliedView NMS Service, right-click AlliedView NMS in the Services window, and then 
select Start from the pop-up menu. The Service Control pop-up window may appear briefly, and then the 
AlliedView NMS Status field will change to Started in the Services window. Allow approximately 60 seconds 
for the server to initialize. After the 60-second initialization period, the AlliedView NMS Server will be ready to 
accept client connections.

4.1.2  Starting the NMS Server from the Start Menu
Note: Using the Services window (see 4.1.1) is the recommended way to start the NMS server.

To start the AlliedView NMS Server from the Start menu, select Start -> Programs -> Allied Telesis -> Allied-
View NMS -> Start Server. The AlliedView NMS window will appear. In the window title bar, you will see DO 
NOT CLOSE. Do not close this window as it will cause the server process to fail.

Several messages will scroll by in the AlliedView NMS window as the server software initializes. You will see 
the following message in the AlliedView NMS window when the server is ready:

Please connect your client to the web server on port: 9090

At this point, the server is ready to accept client connections. You can iconify the two server windows to get 
them out of your way, but do not close either window. If you need to shut down the server, refer to Chapter 5.

4.2  Starting the AlliedView NMS Server on Solaris
To start the AlliedView NMS Server on a Solaris platform, perform the following steps:

1. Log on as root or as a user with root privileges.
2. Change your current directory (cd) to /opt/AlliedTelesis/AlliedViewNMS/bin.
3. Execute file ./startnms.sh & (& is optional)
4. Allow the server to initialize.
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4.3  Starting the Client (Logon Screens)

4.3.1  Overview
The AlliedView NMS application client may be run locally on the AlliedView NMS server, or remotely on any 
java-enabled Windows, Solaris, or Linux system, The local installation is installed during the normal AlliedView 
NMS server installation process (Section 2) and the Remote Client is installed using the Java Web Start technol-
ogy via the remote client’s java-enabled web browser. The local and remote functionality is identical.

4.3.2  Local Application Client 
The application client is installed on the server during the installation. 

4.3.2.1 Windows 

In Windows it can be accessed by choosing Start -> Programs -> Allied Telesis -> AlliedView NMS -> Start 
Client.

FIGURE 4-2  Application Client Logon Window
Clicking on Advanced brings up other options.

4.3.2.2 Solaris

In Solaris it can accessed by going to <NMS_home>/bin, then ./startApplicationClient.sh

4.3.3  Remote Client - Java Web Start1

4.3.3.1 Overview

Java Web Start is a helper application that allows the AlliedView NMS client to run the AlliedView NMS 
remotely via the Internet as a user application rather than as an HTML client. Java Web Start is installed from the 
AlliedView NMS Server via HTTP and must be installed on the client machine before the user can use it. A first-
time installation is typically performed on a new client machine or when the AlliedView NMS is first deployed. 
The AlliedView NMS Server must be running in order to install the Java Web Start Client.

1. Registered Trademark ® Sun Microsystems. All rights reserved.
4-3AlliedView NMS Installation Guide (Starting Up AlliedView NMS 12.0)



Starting the Client (Logon Screens) Remote Client - Java Web Start
4.3.3.2 Installing Java Web Start Client

From your Web browser, enter the following address 

http://<server ip address>:9090

where server ip address is the IP address of the AlliedView NMS Server. 

The AlliedView NMS logon screen will appear as shown in the following figure.

FIGURE 4-3  AlliedView NMS Client Logon Screen
1. Click Launch on the Application Client (Web Start) from the Logon and allow the application to load. 

This will download Java Web Start from the AlliedView NMS as shown in the following figure.

FIGURE 4-4  Java Web Start Download
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2. If Java Web Start is not installed, you will be given the option of installing it from the Sun Web site. You can 
also install it from the AlliedView NMS Logon screen (refer to Figure  4-3) by clicking on Download Java 
1.6.

Note: Installing from the AlliedView NMS Logon screen (refer to Figure  4-3) is preferred since it will 
always contain the correct version of the jre software.

For Solaris, click the Sun Microsystem’s Binary Code Agreement link and read the license agreement. 

3. A digital signature screen then appears, asking if you trust the origin of the application, as shown in the fol-
lowing figure. Select Run.

FIGURE 4-5  Digital Signature Screen
4. When the AlliedView NMS Authentication window appears, enter root as the username and public as the 

password, and then click Connect. The AlliedView NMS Application screen will appear, with the IP Topol-
ogy screen. Refer to the AlliedView NMS Administration Guide and the AlliedView NMS User Guide for more 
information.

Note: It is highly recommended that you change your password immediately upon first logging in. 
The root username and public password are defaults for the AlliedView NMS. Leaving the 
default password may make your NMS vulnerable to unauthorized access. Refer to the 
AlliedView NMS Administration Guide for information on changing the password.

5. Verify that the client can log in and that the AlliedView NMS starts up and displays properly on the client 
machine.

6. If you wish to exit the AlliedView NMS, from the panel-specific menu, select File -> Exit.
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4.3.4  HTML Client
For starting the AlliedView NMS Client for simple network monitoring over a slow dialup link, it is recom-
mended that you use the HTML client. To start the AlliedView NMS HTML Client, follow these steps:

1. In your Web browser, enter the following address: 
http://<server ip address>:9090

where server ip address is the IP address of the AlliedView NMS Server. The AlliedView NMS logon screen 
shown in Figure  4-3 will appear.

2. In the Web Client (HTML) section, enter root as the username and public as the password, and then click 
Login. The HTML Client view will appear.

Note: It is highly recommended that you change your password immediately upon first logging in. 
The root username and public password are known defaults for the AlliedView NMS. Leaving 
the default password may make your NMS vulnerable to unauthorized access. Refer to the 
NMS Administration Guide for information on changing the password.

3. Refer to the AlliedView NMS User Guide and the AlliedView NMS Administration Guide for information on 
using the HTML interface.

4.3.5  Client Limitations
• The Java Web Start Client may throw exception InvalidClassException.

Java Web Start is a client-side technology that downloads software from the AlliedView NMS Server via 
HTTP and executes it on the local (client) host. The AlliedView NMS Java Web Start client makes use of 
this technology to keep client software synchronized with the NMS Server software when the NMS is 
upgraded. However, the AlliedView NMS Java Web Start Client does not handle the case where the server is 
downgraded from a new version to an older version. 

For example, if a user has the AlliedView NMS 12.0 server running on a host, and then replaces it with the 
AlliedView NMS 11.0, the Java Web Start clients that had downloaded the 12.0 software must remove their 
current Java Web Start Client and download it again from the AlliedView NMS 11.0 Server.

If the AlliedView NMS Web Start client is not re-installed as described above, the UnmarshallException and 
InvalidClassException messages will be seen in the Java Web Start console.

• By default, a maximum of five users may be logged in on the AlliedView NMS at any given time.

The AlliedView NMS supports a maximum of five simultaneous client sessions. If a user attempts to log in 
when five users are already connected, the user’s login attempt will fail with an error message indicating that 
the maximum number of client sessions has been reached. The user will be able to log in when one or more 
of the current users logs out.

Note: There is a license option to allow more than five clients.
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4.3.6  Other Logon Screen Links
At the bottom of the NMS Logon screen are the following links:

• About - This includes an overview of the product and a link to the Allied Telesis website.
• Contact - This creates an email addressed to ATI Sales.
• Documentation - This includes links to the pdf versions of the Administration Guide and User Guide, and to 

the online help (How to Use Online Help screen appears first).
• Alternate Client - This will run the NMS client as an applet rather than a Web Start client.
• Download Java 1.6 - This brings up a form to download Java 1.6.0_16 from the NMS Server.
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5. Shutting Down the AlliedView 
NMS
5.1  Shutting Down a AlliedView NMS Client

5.1.1  Application Client
For an NMS client running as a user application, to shut down the client, simply select File -> Exit from the 
Panel-Specific Menu, or click the X in the upper-right-hand corner of the screen. The Confirmation Message 
dialog box will appear. Click Yes in the dialog box to shut down the client.

5.1.2  HTML Client
For a AlliedView NMS HTML client, select File -> Logout from the AlliedView NMS Panel-Specific Menu.

5.2  Shutting Down the AlliedView NMS Server

5.2.1  Windows
To shut down the AlliedView NMS Server on a Windows platform, follow these steps:

1. Select Start -> Programs -> Allied Telesis -> <AlliedView NMS load> -> Shutdown Server. The Shutdown 
Server window will appear. Do not close this window. Shortly afterwards, the Shutdown AlliedView NMS 
Server dialog box will appear. 

Note: Click Cancel if you decide not to shut down the server.

2. In the Shutdown AlliedView NMS Server dialog box, enter the root user password in the Password field.
3. If you want to change the shutdown mode:

1. Click Settings. This will display the Mode of Shutdown window.
2. In the Mode of Shutdown window, select the desired mode.
3. Click OK.

4. Click OK. Allow a few seconds for the server to shut down. The Server Shutdown dialog box will appear 
when the shutdown is complete.

5. Click OK in the Server Shutdown dialog box.
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5.2.2  Solaris
To shut down the AlliedView NMS Server on a Solaris platform, follow these steps:

1. Log in as root or as a user with root privileges.
2. Change your current directory (cd) to <NMS_HOME>/bin.
3. Execute file ShutDown.sh.
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6. Uninstalling the AlliedView NMS
6.1  Overview
The process for uninstalling the AlliedView NMS depends on the operating system being used.

6.2  Windows
To uninstall the AlliedView NMS from a computer running Windows, follow these steps:

1. Shut down any client connections and the server. Refer to Section 5.
2. Select Start -> Programs -> Allied Telesis -> AlliedView NMS_load->Tools -> Uninstall. The AlliedView 

NMS InstallShield will appear, as shown in Figure 1.

FIGURE 6-1  Uninstall NMS R12.0 - Initial Screen
3. Click Next. This will display the next window, which shows the location from where the software will be uni-

stalled, as shown in Figure 2. Continue by selecting Next. There will a progress screen, and then a Finsih 
screen, as shwon in Figures 3 and 4.
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Windows
FIGURE 6-2  Uninstall  - Path to R12.0 Software Directory

FIGURE 6-3  Uninstall AlliedView NMS R12.0 - Progress
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Solaris
FIGURE 6-4  Uninstall AlliedView NMS R12.0 - Finish

6.3  Solaris
To uninstall the AlliedView NMS from a computer running Solaris, follow these steps:

1. Log in as root or as a user with root privileges.
2. Change your current directory (cd) to <NMS_HOME>/_uninst.
3. Execute file uninstaller.bin.
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7. Installing and Uninstalling a 12.0 
Service Pack (R12 SPx)
Note: Uninstalling the NMS Upgrade Pack for R12.0 is covered in Section 3, since in R12.0 the 
Upgrade Pack is unique in how it is installed and removed. This Section assumes that the 
upgrade to 12.0 is successful, and the user is now installing the R12 Service Pack.

7.1  Installing the R12 Service Pack

7.1.1  Overview
The service pack is used to bring your AlliedView NMS to a point release within the major software release. The 
process is identical for both Windows and Solaris. In 12.0 the same service pack is used for Solaris and Win-
dows.

Note: Prior to this procedure, perform a server backup.

7.1.2  Upgrading the NMS Server
1. Shut down the NMS Server. Refer to Chapter 5.

Caution: You must shut down the AlliedView NMS server; otherwise, the AlliedView NMS server 
cannot successfully install the upgrade pack.

2. In your <NMS_HOME>\bin directory and locate file UpdateManager. Execute this file. This will bring up 
the AlliedView NMS Update Manager window shown in the following figure.

Note: Use the UpdateManager.bat file for Windows, or the UpdateManager.sh file for Solaris.

Note: In addition to starting the update manager from the bin directory with the command, you can 
instead start it from Start -> Programs -> Allied Telesis ->AlliedView NMS -> Tools -> 
Update Manager
7-1 AlliedView NMS Installation Guide (Installing and Uninstalling a 12.0 Service Pack (R12 



Installing the R12 Service Pack Upgrading the NMS Server
FIGURE 7-1  AlliedView NMS Update Manager

FIGURE 7-2  AlliedView NMS Update Manager Installation Wizard
3. In the Installation Wizard window, click Browse. This will bring up the Select a File window. Refer to the 

following figure.
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FIGURE 7-3  AlliedView NMS Select a File Window
4. In the Select a File window, navigate to the Service Pack file located on the installation CD-ROM. This file 

will have a .ppm file extension. Double-click this file, or select the file and then click Open. This will close 
the Select a File window.

5. In the Installation Wizard window, if you wish to view the Readme file for this update, click Readme.
6. Click Install to apply the update. The update process will begin. The Installation Wizard window will track 

the progress as shown in the following figure.

Note: If you do not wish to view the Readme file and the installation log file upon completion, 
uncheck the View Readme and Log checkbox. This can be done during the installation 
process.
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FIGURE 7-4  AlliedView NMS Update Manager Installation Wizard Update In Progress
7. Allow the installation to complete, and then click Close.
8. The AlliedView NMS Update Manager window will now show the installed Service Pack as shown in the 

following figure. 
9. The Service Pack is now installed. Click Exit to exit the AlliedView NMS Update Manager.
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FIGURE 7-5  Update Manager Showing the Installed Service Pack
10. Start the NMS Server. Refer to Chapter 4.
11. The installation is now complete.

7.1.3  Ensuring the Service Pack is Running Correctly
Once the R12.0 Service Pack is installed and running, you should verify that all functions of the NMS function 
correctly. Refer to 3.2.7 for types of tests to run.

If any of these do not seem to work as previously, or there is some problem that should not be occurring, contact 
your Allied Telesis representative before taking any recovery action, such as uninstalling the Service Pack (refer 
to 7.2).

7.2  Uninstalling an AlliedView NMS Service Pack
Note: Uninstalling an NMS Service Pack is only necessary if the Service Pack is determined to be 

faulty and must be removed.

Note: The uninstallation procedure is identical for Windows and Solaris.

To uninstall a AlliedView NMS Service Pack, perform the following steps:
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1. Shut down the NMS Server. Refer to Chapter 5.
2. In your <NMS_HOME>\bin directory, locate file UpdateManager. Execute this file. The AlliedView 

NMS Update Manager window will appear as shown in the following figure.

Note: Use the UpdateManager.bat file for Windows, or the UpdateManager.sh file for Solaris. 

FIGURE 7-6  NMS Update Manager Window Showing Installed Service Packs
3. Click on the Service Pack you want to remove, and then click Uninstall. 

Caution: If you choose more than one SP to uninstall, the NMS will choose the lowest version 
of software and all higher versions.

4. The Uninstall window will appear as shown in the following figure.
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FIGURE 7-7  NMS Update Manager Uninstall Window
5. Click Finish. The uninstallation process will begin. The Uninstall window will track the progress as shown 

in the following figure.
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FIGURE 7-8  NMS Update Manager Uninstall Progress
Note: If you want the Uninstall window to close after the uninstallation is complete, check the 

Automatically close after uninstallation checkbox. You can do this during the uninstallation 
process.

6. Allow the uninstallation process to complete. If the Uninstall window did not close automatically, click 
Close to close it. The AlliedView NMS Update Manager window will no longer show the uninstalled Ser-
vice Pack.

7. In the AlliedView NMS Update Manager window, click Exit to exit the NMS Update Manager. The Ser-
vice Pack is now removed.

8. Restore the database files. Refer to the Allied View NMS Administration Guide.
9. Start the NMS Server. Refer to Chapter 4.
10. For each PC running the the NMS WebStart java client, delete the temporary files. For example, for Win-

dows XP:

a. Access the Java Control Panel (such as Start -> Control Panel, then open the Java Control panel).

b. In the General tab, Temporary Internet Files panel, select Settings, then in the Temporary Files Setting 
window, select Delete Files. 

c. In the Delete Temporary Files window, select both types of files, then OK. Refer to the following figure.
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FIGURE 7-9  

d. Once the files are deleted, the Delete Temporary Files window closes.

e. Click OK on Temporary Files Settings and the Java Control Panel.

11. The uninstall procedure is complete.
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8. Adding the NMS to a Network
The previous sections of this Guide have shown how the various components of the AlliedView NMS are 
installed on the server and clients. The NMS Administration Guide explains how the NMS programs and config-
uration discover the network devices so that they are displayed and managed by the AlliedView NMS interface.

The following lists the steps to go through the installation of the NMS and the network devices to ensure that all 
devices are able to be discovered, the AlliedView NMS and the devices are physically connected, and the NMS is 
polling and receiving the appropriate data from the devices. 

8.1  NMS and iMAP/AT Device Software Version 
Compatibility
For every version of the AlliedView NMS, there is a list of devices that the version of AlliedView NMS will sup-
port, as well as the software version of these devices. 

Caution: Refer to the AlliedView NMS Administration Guide for the list of devices and their 
software versions supported by the latest version of the AlliedView NMS. If there is 
any question about compatibility, consult with your authorized Allied Telesis 
representative.
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8.2  Configuring a New NMS with New Devices
If the AlliedView NMS is being installed for the first time and a new network is being configured, the network, 
the devices, and the network interface to other networks need to be configured, as well as the AlliedView NMS.

Caution: Ensure the AlliedView NMS and the devices have layer 3 connectivity; if this is not 
done, the devices will not be able to communicate with the AlliedView NMS server.

TABLE 8-1  Steps for a New AlliedView NMS with New Devices 

Step Details / Reference Notes

1. Evaluate Network Config-
uration Requirements

Ensure all network configuration information is 
recorded and what changes (such as Network 
VLANs) will be required

2. Install the AlliedView 
NMS on the Server

Refer to Section 2. For the latest version of a 
AlliedView NMS release, the 
CD may contain a Service Pack 
that must be installed as well. 
Refer to Section 3.

3. Confirm the telnet server is 
working

This must be done for each device For Rapier devices, the default is 
on. For iMAP devices, use 
>enable telnet.

4. Start up the SNMP agent This must be done for each device

5. Physically connect the 
AlliedView NMS to the 
network

For any issues specific to Windows or Solaris, 
refer to their connectivity Guides.

6. Start the AlliedView NMS On the NMS, select Start ->AlliedTelesis-> 
<Load_Name> -> Start Client. (If you did 
not set the NMS server as Autostart, you will 
have to select Start Server first.)

When the NMS GUI appears, the only network 
that appears is the one the server is a member 
of.

Be sure the default user id and 
password for Rapier devices 
(friend, friend), iMAP devices 
(officer, officer) and the NMS 
(root, public) is changed.

7. Use the Discovery Config-
urator to Prepare for the 
Discovery Process

Select Tools -> Discovery Configurator to 
bring up the Discovery Configurator Win-
dow. Then follow the tabs:
- General Attributes

- CLI Login

- Protocol (always SNMP only)

- Network and Node Discovery

Refer to the Administration Guide, Section 3

The Discovery Configurator 
is used to configure the 
attributes of the discovery 
process, and so it is critical 
that these be set up correctly.

8. Use the Security Adminis-
trator

Set up NMS users with passwords and scope of 
control. 

Refer to the Administration Guide, Section 4.
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9. Import Link Profiles Create an excel spreadsheet and place it in 
<NMS Home>\state.

Refer to the Administration Guide, Section 
6.7.3.

Since the physical link configu-
ration for an existing network 
can be large and complex, the 
Network VLAN Manager can 
have an Excel spreadsheet of the 
physical links imported. This 
will populate the Physical Net-
work map, and any existing Net-
work VLANs that use those 
links will be configured.

10. Set Device Attributes Refer to the Administration Guide, Section 5.

11. Configure Applications Refer to the Administration Guide, Sections 5 
and 6.

With all devices discovered and 
being monitored, it is now possi-
ble to configure applications 
such as VLANs, HVLANs, and 
Network VLANs.

12. Perform a AlliedView 
NMS Backup

Make a backup of both the AlliedView NMS 
file, the database, and devices

Refer to the Administration Guide, Section 3.4, 
and Section 5.

Do this on a schedule to ensure 
whenever changes due to Steps 
11 and 12 are captured and 
archived.

TABLE 8-1  Steps for a New AlliedView NMS with New Devices (Continued)

Step Details / Reference Notes
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9. Appendix A - Enabling 
Anonymous FTP
9.1  Overview
Use the following steps to enable anonymous FTP on the Backend Server. Refer to the AlliedView NMS Admin-
istration Guide for how this works.

9.2  Windows 2003
1. Control Panel -> Add/Remove Programs -> Add/Remove Windows Components
2. Select (without checking) Internet Information Services (IIS)

Note: For Windows 2003, Internet Information Services is under Application Server -> Details.

3. Click on Details
4. Check File Transfer Protocol Server, which will check its dependencies
5. Click Okay
6. Load the CD if prompted and enter the path D:\ENGLISH\WIN2000\ADV_SERV\I386

The default configuration will consist of:

• Anonymous access only, with passwords under Windows control
• Read access only
• Root is C:\inetpub\ftproot
• Logging is enabled

Write access has to be enabled. Other defaults may be modified. If the ftp root directory is modified, then it has 
to be added to the AlliedView NMS config file conf\AT_server.properties.

1. Control Panel -> Administrative Tools -> Internet Services Manager
2. Select the host
3. Select the “Default FTP Site”
4. Right click and select Properties
5. Select the “Home Directory” tab and enable Write access.

Note: Currently, Step 5 is required for GenBand devices; otherwise GenBand backups to the backup 
directory will fail.

9.3  Windows 2008
1. Access the Control Panel.
2. In Control Panel Window, select Administrative Tools
3. In the Administrative Tools window, select Server Manager
4. In the Server Manager window, expand (if needed) Roles Summary and Roles, and then select Add Roles. 

Refer to the following figure.
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FIGURE 9-1  Adding a Role
5. The Add Roles Wizard with an overview appears. Select Next.
6. The Server Roles window appears. Select Web Server (IIS). You may get a pop-up to add required features. 

Refer to the following figure. 

FIGURE 9-2  Adding Required Services for Web Server (IIS)
7. Select Add Required Features. The Web Server (IIS) tic box is now selected. Select Next.
8. The Introduction to Web Server (IIS) window reappears, where you can get additional information. Select 

Next.
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9. In the Select Roles Services window, select FTP Publishing Service. A pop-up may appear for Required Role 
Services. Refer to the following figure.

FIGURE 9-3  Adding Role Services
10. Select Add Required Role Services, then select Next.
11. In the Confirmation window, select Install.
12. The Progress window appears, and when finished the Results window shows the installation has succeeded. 

Select Close.
13. Go back to the Server Manager window, and select the link WebServer (IIS).
14. In the Web Server IIS window, select FTP Publishing Service and Select Start. Refer to the following figure.
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FIGURE 9-4  Starting the FTP Publishing Service
15. Once the status is Running, click on Go to Services.
16. In the Services window, right click on FTP Publishing Services and select Properties.
17. In the properties window, change the Startup Type to Automatic and select Apply. Refer to the following fig-

ure.

FIGURE 9-5  Setting Startup to Automatic
18. Go back to the Web Server (IIS) window. The FTP Publishing Service should be set to Status=Started and 

Startup Type= Automatic.
19. Restart the server.
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20. Select Start > Administrative Tools > Internet Information Services (IIS) 6.0 Manager as shown in the fol-
lowing figure.

FIGURE 9-6  Bring up IIS 6.0 Manager
21. The IIS 6.0 Manager window opens. Expand the tree in left panel to the Default FTP Site.

FIGURE 9-7  IIS 6.0 Manager
22. Right-click Default FTP Site, and select Properties. The Default FTP Site Properties window opens. In the 

Home Directory tab, check the Write checkbox, as shown in the following figure. Click OK.
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FIGURE 9-8  Selecting Write Checkbox in Home Directory
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23. In the IIS 6.0 Manager window, right-click Default FTP Site, and select Permissions. The following win-
dow opens.

FIGURE 9-9  ftproot Window
9-7AlliedView NMS Installation Guide (Appendix A - Enabling Anonymous FTP)



Windows 2008
24. Click Edit. The Permissions window opens. Select Users, and click the Write checkbox, as shown in the fol-
lowing figure.

FIGURE 9-10  Setting Write Permission for Users
25. Click OK, then click OK again.
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9.4  Solaris
Configuring FTP on Solaris can be a complex and difficult task if your system has been altered from the original 
installation. On the other hand, it's a relatively straight-forward task if your system does not deviate from the 
default Solaris installation. 

Due to variations among UNIX and Solaris systems, however, this procedure cannot be reliably automated. What 
follows is a procedure that can be followed on an unaltered system that will configure anonymous FTP service 
suitable for AlliedView NMS. 

This procedure assumes the ftp root directory will be /opt/ftp. Shell commands to execute this procedure are 
provided at the end of this section. If your system has been altered from the original installation or /opt has not 
been mounted with enough memory to handle file transfers (100 MB), you will have to modify this procedure 
accordingly. FTP configuration is extensively documented in the Solaris man pages and on the web. For more 
information, options, details, and security considerations, see the man pages for in.ftpd or ftpd and ftpac-
cess or contact your system administrator.

Note: This procedure may require 30 minutes or more-depending on your particular Solaris 
installation and how much it differs from the default installation.

The AlliedView NMS will need read/write file access to the FTP pub directory and FTP clients (iMG/RG and 
GenBand) will need retrieve and upload server permissions.

Note: The following procedure assumes the ftp home directory and anonymous ftp root directory will 
be /opt/ftp. If you decide to use a different directory because of system constraints, then 
replace all occurrences of /opt/ftp with your directory name throughout the procedure.

9.4.1  Creating the Anonymous FTP Account
1. Begin the configuration procedure by logging in as root and creating the ftp account with the useradd com-

mand. (Shell commands are listed at the end of this section)
2. Set the /etc/passwd and /etc/shadow entries for anonymous usage. The ftp entry in /etc/passwd 

needs to look something like:
ftp:x:30000:30000:Anonymous FTP:/opt/ftp:/nosuchshell

Note: The 30000 will be some number created by the useradd command and already in the file. 
Don't change it to 30000. Use the number already there, but change the text that follows the 
30000.

3. The ftp entry in /etc/shadow should look like:
ftp:NP:6445::::::

9.4.2  Create the FTP Directory Tree
Now create the ftp directory tree, configure the ls command, copy shared libraries, and set file permissions. 

1. Create the following subdirectories under the ftp root:

/opt/ftp

/opt/ftp/bin

/opt/ftp/pub

/opt/ftp/usr

/opt/ftp/lbin

/opt/ftp/lib

/opt/ftp/usr/bin
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/opt/ftp/usr/lib

2. Set up the “ls” command for the anonymous user:
ln s /usr/bin/ls /opt/ftp/bin/ls

cp /usr/bin/ls /opt/ftp/usr/bin

3. Copy the following shared libraries to usr/lib (it's possible some of these libraries don't exist on certain ver-
sions of Solaris, but their functionality is still available in the other libraries that do exist):
/usr/lib/ld.so.1*

/usr/lib/libc.so.1*

/usr/lib/libdl.so.1*

/usr/lib/libmp.so.1*

/usr/lib/libnsl.so.1*

/usr/lib/libsocket.so.1*

/usr/lib/nss_compat.so.1*

/usr/lib/nss_dns.so.1*

/usr/lib/nss_files.so.1*

/usr/lib/nss_nis.so.1*

/usr/lib/nss_nisplus.so.1*

/usr/lib/nss_xfn.so.1*

/usr/lib/straddr.so*

/usr/lib/straddr.so.2*

4. Set file permissions to allow read-execute to all directories, read-only to the ls command, and read-write-exe-
cute to pub:
chmod 555 /opt/ftp/bin

chmod 777 /opt/ftp/pub

chmod 555 /opt/ftp/usr

chmod 555 /opt/ftp/usr/bin

chmod 111 /opt/ftp/usr/bin/ls

chmod 555 /opt/ftp/usr/lib

9.4.3  Configure Upload Permission on Solaris 10
1. For Solaris 10, give clients upload permission by adding the following 4 lines to the end of /etc/ftpd/ftpac-

cess:
uploadclass=anonusers   * /pub yes ftp 30000 0660 dirs

deleteyesanonymous

overwriteyesanonymous

renameyesanonymous

9.4.4  Test Anonymous FTP Service
Test the configuration by attempting to connect to the ftp service from a remote client, making a directory, 
uploading a file, list files, retrieving the file, deleting the file, and finally removing the created directory. Accept-
able user names are ftp and anonymous. Almost anything will be an acceptable password.
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9.4.5  Configure AlliedView NMS (if necessary)
AlliedView NMS will assume the ftp root directory is /opt/ftp. To specify a different ftp root, edit the 
FTP_ROOT entry in the AlliedView NMS config file conf/AT_server.properties.
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9.4.6  Shell Commands
The following shell commands will configure anonymous FTP service suitable for AlliedView NMS on most 
Solaris installations. Due to variations in system administration from one system to another, this procedure can-
not be guaranteed to work on all Solaris systems. 

You are advised to create and configure the ftp account interactively in case errors occur.
#

# You must be logged-in as root to configure anonymous FTP

# 

useradd ftp

cd /etc

#The following is ONE line

sed -e 's/^\(ftp:x\):\([0-9]\{1,\}\).*$/\1:\2:\2:Anonymous FTP:\/opt\/
ftp:nosuchshell/' passwd > passwd~

#

sed -e 's/^ftp.*$/ftp:NP:6445::::::/' shadow > shadow~

#

# Verify the settings before making them permanent.

#

more passwd~

more shadow~

#

# Make the verified settings permanent

#

# CAUTION: ANY ERRORS HERE MAY BE IMPOSSIBLE TO FIX.

# 

chmod 660 /etc/passwd /etc/shadow

mv passwd~ passwd

mv shadow~ shadow

mv passwd~ passwd

chmod 440 /etc/passwd /etc/shadow

The rest of the shell commands, which also must be executed while logged-in as root, are listed in the file 
bin/AT_configure_ftp.sh. Any system-specific errors from these commands are typically harmless. In fact, 
on certain installations, some of the shared libraries are obsolete, so “file not found” errors will be expected. The 
last four commands in the file are to be used with Solaris 9 and 10, so skip them to use on Solaris 8.
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10. Appendix B - Activating NMS 
Software License
10.1  Overview
To activate the NMS software license includes the following:

• The license key is not associated with the server, but associated with the customer who has registered the 
license.

• Allied Telesis will work with the customer to gather relevant information and determine what features the 
customer wants and the software package that is therefore needed.

• Licensing can include the following features:
• whether the license is temporary (time limit)
• a single or distributed server
• the maximum number of nodes allowed (the default for the evaluation copy is 100 nodes)
• allowing access to the Northbound Interface.

• The details of the license key are encrypted and kept in xml format as AT_License.conf in the Conf subdirec-
tory. (The file is put there when the License Key Installer is run.)

Caution: This file must not be edited manually; otherwise the keys in the file will be invalid, and 
the AlliedView NMS could stop running.

The process of obtaining a license includes the following:

1. The customer works with Allied Telesis, which gathers the customer information.
2. Allied Telesis encodes the customer information and license privileges in a customer unique file, such as 

customername_I1932_A_NMS_N1000_NB_C5_KEY_UPD.
3. The customer receives the file and places it on the NMS server.
4. The customer uses the License Manger GUI to find this file and apply the license.
5. The status of the current (installed) license keys can be viewed using the key installer (top panel) or the Status 

Monitoring application.

Note: All NMS customers prior to 10.0 will get a new 10.0 license key, and must use the above 
process. Otherwise, there is a time limit on how long the 10.0 features will function.

10.2  Installing a License (Using the License Key 
Manager)
The License Key Manager is included with the NMS release so that it can be used to apply the license key. The 
GUI is an improvement to the previous similar to existing license key tool, but the License Manager has more 
features and presents more information when installing the key.

As in previous license keys, the new key can be installed while the server is running without affecting other ser-
vices. Some sections of the key will take effect immediately (e.g. node limit), and others will take effect after the 
next server restart.

When a new key is installed, it will overwrite a previous key. Also, the installed key will not be removable (i.e. 
there will be no tools to uninstall a key) but a new key can be created to reset the unwanted key to original or any 
other values.
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Refer to the following figure, which shows the License Manager Tool.

FIGURE 10-1  License Manager Tool - Release 12.0
The license key installation user interface has three main sections:

• Current License Information (Top): This section has information on the key that is already installed. It dis-
plays the license status including user information, product and all components being licensed.

• License File Selection (Middle): This section allows the user to select the license file to be applied. The 
license key file is expected to be on the server and contain the correct extension and the file chooser can be 
used to select a file from the file system mounted in the server.

Note: By default, the Select File will go to the <NMS-Home> directory, and filter the display to show 
the License Update File types, as shown below.
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Installing a License (Using the License Key Manager)
FIGURE 10-2  Example .upd file to Select

• Installation Progress (Bottom): This section will display status of the current license installation and the infor-
mation printed here will be very useful if the installation fails.

When the user clicks on the Select button (to place the file as the License Selection), and then the Apply button 
on the License Manager, the file is read and checked, then installed, and then verified. If there is an error during 
these steps, the installation will stop. If there are no errors, the file is stored at another location if needed later for 
recovery. 

There is also a License Key History (Separate panel): This is launched by selecting the History button to display 
the history of all licenses that have been installed on the system in the past. Refer to the following figure. To Be 
Supplied
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FIGURE 10-3  License History
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Applying the License -Steps Installing a License (Using the License Key Manager)
10.2.1  Applying the License -Steps
Once the license is delivered to you it must be copied to the NMS server. This key may be applied to a running 
NMS server. Some parts will take effect immediately, and others will take effect after a system restart.

Note: This procedure must be run on the NMS Server with Administrator (W2003 or W2008) or root 
(Solaris) privileges.

10.2.1.1 Windows
1. Copy the license activator key (<filename>.upd) on to the NMS server directory
2. Bring up the File Update Tool Form.

10.2.1.2 Solaris
1. Copy the license activator key (<filename>.upd) on to the NMS server directory.
2. Change to the <NMS-home>/bin directory.
3. Run ./AT_LicenseKeyInstaller.sh
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10.2.1.3 Apply the License

For either system, the License Manager appears, as shown in the following figure.

FIGURE 10-4  File Update Tool Form
1. Use the Select File to locate the License.upd file
2. Select Apply to install the license.
3. When the success message is received, select Close to close the window.
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11. Appendix C - Client Limitations 
on Dual NIC Server on Isolated Networks
11.1  Overview of Configuration and Limitation
The NMS server cannot provide client-side access to the secondary IP interface on a dual-NIC server when the 
interfaces reside on isolated networks. (The underlying Java RMI objects contain call-back references to the pri-
mary IP only, not the secondary.). Therefore, clients establishing connectivity on the secondary IP interface will 
receive RMI callback address references to the primary side, which is unreachable from that client in the second-
ary network. Refer to the following figure.

FIGURE 11-1  Application Client on Secondary Network Cannot Access Server

11.2  Solutions

11.2.1  A - Single IP Bridge to Primary Interface
Note: This solution will work where 100% isolation is not required by the customer.

The solution requires the creation of a pass-through from the secondary network to the primary IP address of the 
NMS server. Only the primary IP of the NMS server should be allowed to route from the secondary, minimizing 
a breach in network security.

An advantage of this solution is that it is a one-time network reconfiguration and does not require any on-going 
modifications to the NMS server or new client machines.

The disadvantage is that it provides a potential network security breach from the secondary network to the NMS 
server. 

Refer to the following figure.
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FIGURE 11-2  Solution A - IP Bridge to Primary Interface
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B - NMS Server and Client Routing Configuration Solutions
11.2.2  B - NMS Server and Client Routing Configuration
This solution requires modifications to the NMS server and client machines and (optionally) separate DNS serv-
ers on each of the isolated networks. The modifications on the NMS server force the RMI object to be created 
with hostname as opposed to IP address callbacks. The client must reconcile this hostname to the proper NMS 
server IP interface either by a DNS look up or its own internal routing table.

An advantage of this solution is that it maintains the isolated network configuration.

The disadvantage is that it requires the routing tables of the client machines to be modified in order to reconcile 
the network-dependent hostname, or it requires the separate DNS servers that reconcile the hostname to reconcile 
to different IP addresses depending on the network in which they reside.

Refer to the following figure.

FIGURE 11-3  Solution B - NMS Server and Client Configuration
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